Enhancing Presentation

Introduction

We have already learned how to create digital presentations using LibreOffice Impress. We have
made slideshows on a variety of topics, adding multiple slides and different multimedia elements to
them. We also know how to use various master pages and layouts to effectively present different
types of data.

In this chapter, we will learn how to take our Impress presentations to the next level by using some of
its more advanced features. We will discover how to:
° Add transition and animation effects to our slides and their content.
Insert consistent content across all slides, like the date or time.

e  Createnew slide masters and templates for our presentations.
e  Utilize drawing and diagrammatic tools within our slides.
e  Customize our slide's page settings.
e  Prepare custom slideshows.
e  Setspecific timings for each slide in our presentation.
e Linkingand exporting presentation.
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current one without any special effect. Impress allows us to preview the chosen transition effect
immediately, helping us decide which one works best.

Now, let us add transition effects to the presentation we created earlier. Follow the steps given below:

e  Gotothe File menu and select Open, or simply press Ctrl + O. The Open dialog box will
appear as shown in figure 10.1. Browse and select the presentation file, then click the
Open button. All of the presentation's slides will appear in the slide pane, ready for us to
work on.
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To apply a transition effect, simply select the specific slide
from the Slide pane that we wish to modify.

In the Tasks pane, click on the Slide Transition section.
Options regarding slide transition are displayed as shown in
figure 10.2. Under Apply to selected slides selection
list, choose the transition effect we want. If the Automatic
preview checkbox is selected, we will see an instant preview

of'the transition.

From the Speed dropdown menu, select the desired speed:
Slow, Medium, or Fast. Optionally, pick a sound from the
Sound dropdown menu.

To apply the transition to every slide in our presentation,
simply click Apply to All Slides. To see the transition in
action, click the Play button. And to start the slideshow with
the selected transitions, click the Slide Show button.
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Figure 10.2 : Slide Transition

Custom Animation

As we learned previously, animation brings objects to life
through movement. We can apply animation effects to
almost any object on our slide, making presentation more
engaging for viewers.

Let us add some animation effects to the objects on our
slide. Follow the steps given below:

e  Openthepresentation we made for our school.

e  Select a slide and the object we want to
animate.

e  Click the Custom Animation section in the
Tasks panes. This will display options for
adding animation to our object.

e  Click the Add button. This will open the

Custom Animation dialog box as shown in
figure 10.3.
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Figure 10.3 : Custom Animation Dialog Box

e  Asshowninfigure, the Custom Animation dialog box has several sections, including:
Entrance: How an object appears on the slide.

Exit: How an object leaves the slide.

O O O O

Emphasis: Effects that draw attention to an object already on the slide.

Motion Paths: Defines a path for the object to move along.
Misc Effects: A category for various other effects.

e  Choose an animation effect of our choice.We can repeat this process to add animations
to other objects on our slide. After applying animations to several objects on a slide, the
Custom Animation section in the Slide pane will appear as shown in the figure 10.4.
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Figure 10.4 : Custom Animation Effect Applied to Slide Objects

Letus explore each control in the Custom Animation section of the Tasks pane.

Add: We can use this button to open the Custom Animation dialog box, allowing us to select
animation effects for objects on our slide.

Change: We can use this button to change an animation we have already applied.
Remove: We can remove animation using this button.

Start: It offers options like On Click, With Previous, and After Previous. We can choose how our
object animates: either by clicking the mouse, simultaneously with the previous animation, or
immediately following the previous animation.

Speed: We can choose the animation speed for our object from options like Very Slow, Slow,
Medium, Fast,and Very Fast.

Change order: We can change the order in which animations appear by clicking the up and down
arrow buttons.

Adding Content to All Slides

We might want to display consistent information on every slide, such as the date, slide number, or
our school's name.The most effective way to add content to all slides in a LibreOffice Impress
presentation is by using Master Slides. A Master Slide (also called a Slide Master) acts as a template
for our presentation. Any content, formatting, or design elements we place on a Master Slide will
automatically appear on all slides that use that specific master.

Follow the steps to insert content to all the slides:

° Click on View in the menu bar and select Master—Slide Master. This will open the

Master View as shown in figure 10.5, where we will see our current master slide in the
left-hand pane. The main workspace will display the selected master slide.
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Figure 10.5 : Adding Content to All the Slides Using Master Slide

In the main workspace, use the text box tool to draw a text box and type a phone number

of our school.We can also add lines, shapes, or other graphic elements from the Drawing
toolbar.

Go to View menu and select Header and Footer. A dialogbox will be opened as shown

infigure 10.6. Select checkboxes for Date and Time and Slide number. Click Apply to All
button.
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Figure 10.6 : Adding Date and Slide Number Using Header and Footer

Select Normal view in View menu. All changes we make to the Master Slide will
automatically appear on every slide in our presentation.
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Creating New Slide Master

Creating anew Slide Master in LibreOffice Impress allows us to design a unique layout and style that
we can then apply to specific slides in our presentation. This is incredibly useful for maintaining
different themes or sections within a single presentation.

Follow the steps to create a new Slide Master for presentation:

° Select View — Master Slide. This will open the Master View, where we will see

thumbnails of existing master slides on the left pane.

° Right-click on any empty space in left pane and from the context menu, select New
Master.

Right-click on the new master slide thumbnail and select Rename Master.... Rename slide dialog box
will appear as shown in figure 10.7. Enter 'My Master Page' as a name for new master. Click 'OK".
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Figure 10.7 : Adding and Renaming New Master Page

) Once new Master Slide is selected, we can begin customizing it. Feel free to add or
modify the placeholders to suit the layout needs. We can also personalize the
background by right-clicking on an empty area of the master slide, selecting Slide —
Page Setup..., and then navigating to the 'Background' tab. Here, we can choose from
various options like a colour, gradient, image, pattern, or hatching to set the desired
background. Figure 10.8 shows the options available in Background tab of Page Setup
dialog box.
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Figure 10.8 : Applying Background to New Slide Master
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° Click the Close Master View button on the Master View toolbar or go to View — Normal.

) In Normal View, we can easily apply our newly created master slide to an existing slide
by selecting it from the Master Slide section within the Tasks pane.

Drawing and Diagrammatic Tools

Impress provides a diverse set of drawing tools to graphically enhance our slides. We will find these
tools located in the Drawing toolbar, typically positioned at the bottom of the Impress interface,
allowing us to easily insert various drawing objects into our presentation. If the Drawing toolbar is
not visible, we can enable it by navigating to View — Toolbars, then selecting Drawing. Figure 10.9
shows the Drawing toolbar.
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Figure 10.9 : Drawing Toolbar

Letus discuss drawing tools, one by one.

Select: This tool selects one or more objects on our slide. When an object is selected, it will display
selection handles (usually small blue squares) around its perimeter. These handles indicate that the
object is active and ready for manipulation. We can drag the selection handles to change size of an
object. To move an object, simply drag the mouse pointer over it.
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Line: The Line tool draws a straight line. We can click and drag from starting point to the end point.
We may hold Shift key to draw perfectly horizontal, vertical, or 45-degree angled lines.

Arrow: This tool draws a line with an arrowhead on one end. We typically use arrow lines to point at
something or to illustrate a flow.

Rectangle: The Rectangle tool lets us draw both rectangles and squares. Simply click and drag to
create arectangle. To draw a perfect square, hold down the Shift key while you drag.

Ellipse: The Ellipse tool draws both ellipses and circles. To create an ellipse, just click and drag. If
we want a perfect circle, hold down the Shift key while you drag.

Text: This tool creates a rectangular area for typing and formatting text. Just click and drag to set the
text box size, then start typing.

Curve: The Curve tool lets you draw freehand curves. Simply click and drag; the curve will follow
the mouse's movement, creating a continuous line. See figure 10.10 (a).

Connectors: These tools are essential for creating diagrams like flowcharts and organization charts.
They automatically stick to objects and adjust when objects are moved. See figure 10.10 (b).

Basic Shapes: This sub-menu typically contains a variety of common shapes such as Triangle,

Trapezoid, Parallelogram, Pentagon, Hexagon, Octagon, Cross, Heart, Sun, Moon etc. See figure
10.10 (c).
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Figure 10.10 : Sub-menus of Curve, Connector and Basic Shapes

Symbol Shapes: Here is a collection of more specialized symbols, including the Smiley Face, No
Entry Sign, Cloud, Lightning Bolt etc. See figure 10.11 (a).

Block Arrows: This sub-menu contains pre-defined arrow shapes with filled areas such as Right Arrow,
Left Arrow, Up Arrow, Down Arrow, Four-pointed Arrow, U-turn Arrow etc. See figure 10.11 (b).
Flowcharts: This menu offers common flowchart shapes, including the Process (rectangle),

Decision (diamond), Start/End (rounded rectangle/oval), Data (parallelogram), and Connector
(circle). See figure 10.11 (¢).
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Figure 10.11 : Sub-menus of Symbol Shapes, Block Arrows and Flowcharts
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Callouts: Callouts are essentially speech and thought bubbles. This submenu includes options like
Rectangular Callout, Rounded Rectangular Callout, Round Callout, Cloud Callout, and Line
Callout. They are perfect for adding commentary or dialogue to our drawings. See figure 10.12 (a).

Stars: This menu offers various star and banner shapes, including the 4-point Star, 5-point Star,
Exploding Star, Ribbon Banner, and Scroll. These are great for adding decorative flair or
highlighting information. See figure 10.12 (b).
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Figure 10.12 : Sub-menus of Callout and Stars

Points: This tool opens a submenu allowing you to add or remove points on an existing line or shape.
We can then drag these points to modify the line or shape.

Glue Points:We can define glue points on our objects. These points allow connectors to attach
precisely, ensuring consistent diagramming.

Fontwork Gallery: The Fontwork Gallery lets us create artistic text effects. Simply click the icon,
pick a style from the gallery, and then edit the text by double clicking it. Figure 10.13 shows the
Fontwork Gallery.
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Figure 10.13 : Fontwork Gallery
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From File: Clicking this tool opens the Picture dialog box, where we can select an image to insert
into our slide.We have already covered how to insert images into slides in the previous chapter.

Gallery:The Gallery is a collection of reusable media objects organized into themes such as
backgrounds, bullets, sounds etc. Figure 10.14 shows the options available in Gallery.
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Figure 10.14 Gallery

Extrusion On/Off: This tool allows us to quickly transform a flat, 2D drawing object into a 3D
object by giving it depth. This process is called 'extrusion'. Clicking this tool opens a group of tools
that letus add or remove extrusion from the selected object.

Page setting

In LibreOffice Impress, Page Setup option gives us control over the fundamental characteristics of
our slides. These settings dictate how our presentation looks both on screen and when printed,
making them essential for defining the overall appearance and feel of our entire presentation.

We can find Page Setup dialog box by clicking on Page option in Format menu. This will open a
dialog box shown in figure 10.15 with two tabs, each controlling different aspects of our slides.
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Figure 10.15 : Page Setup Dialog Box
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Let usunderstands the options in both the tabs.

Page Tab

This tab provides options to customize the slide's dimensions, orientation, and margins as shown in

figure 10.16.

Format: Here, we can define our slide's dimensions. We have the flexibility to select from standard
paper sizes (like A4) or input our own custom width and height. This ensures our slides look correct
on various screens and print accurately on different paper sizes.
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Figure 10.16 : Selecting Dimensions of a Slide

Orientation: We can choose between Portrait (taller than wide) or Landscape (wider than tall)
orientation. Landscape is the default and most common choice for presentations, though Portrait

may be better for certain design needs.

Margins: We can set the top, bottom, left, and right margins of our slides. These margins create the
printable area, ensuring our content is not cut off at the edges.
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Figure 10.17 : Background tab in Page Setup Dialog Box
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Here, we can customize slide's background. We have several options :

None: This option removes the slide's background entirely. See figure 10.17.

Color:We can choose a solid colour for our slide background. See figure 10.18 (a).

Gradient:We can use this option to apply a gradient of two or more colours. See figure 10.18 (b).
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Figure 10.18 : Colour and Gradient Options for Background
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Hatching: This option provides a patterned background with lines (hatching), and we can also set a
background colour for the hatching. See figure 10.19 (a).

Bitmap: This will use an image as slide background. See figure 10.19 (b).
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Figure 10.19 : Hatching and Bitmap Options for Background
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Custom Show
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show as a pre-defined selection of our Figure 10.20 : Custom Slide Shows Dialog Box

original slides, arranged in a specific order, all within the same presentation file.

To create custom slide show, simply click on the Slide show menu, then select the Custom Show
option. This will bring up the Custom Slide Shows dialog box as shown in figure 10.20.

To create a new custom slide show, simply click the New button. This will open the Define Custom
Slide Show dialog box as shown in figure 10.21, where we can give our custom show a name.
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Figure 10.21 : Defining Custom Slide Show

We will see a list of all our presentation's slides in the Existing slides section. Use the >> button to
add slides from this list to our 'Selected slides' list. If we change our mind, the << button will remove
aselected slide. Once we are happy with our custom show's slide selection, click OK.

In the Custom Slide Shows dialog box, we can click Edit button to modify an existing custom show,

or click Delete button to remove one entirely. To begin the custom slide show, simply click Start.

Rehearse Timings

The Rehearse Timings option in Impress is a great feature that helps us practice our presentation and
fine-tune our delivery time. It allows us to run through our slides just like a real presentation, while
Impress automatically records how long we spend on each one.
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Go to the Slide Show menu and select Rehearse Timings. Our presentation will begin in full-screen
mode, and a timer will appear. Advance through your slides just as we would during a live
presentation. Impress will automatically record how much time we spend on each slide. Once we
reach the end, a message will pop up asking if we want to save the new slide timings. Click Yes. Now,
when we play our slideshow, the slides will automatically advance based on the timings we just
recorded.

Linking a Presentation
If we have multiple presentations on the same topic, we can use the Hyperlink feature in Impress to
link them. This feature also allows us to connect to other types of files, websites or email addresses.
Here is how to create a hyperlink:

1. Openthepresentation and select the text or object we want to turn into a link.

2. Goto the Insert menu and choose Hyperlink. A dialog box will open as shown in figure

10.22.
u.!_.‘ Hyperlink type
@ web ETP
Target 3 ey
Maill & News
i
Document
Further settings
Frame » | Form Text
New Docu..
Text
Name
Ap;_n_]u Close Help Back
Figure 10.22 : Hyperlink
3.  Inthisbox, we can choose what we want to link to:
o Internet: Link to a website.
o  Mail: Link to an email address.
o  Document: Link to a file on our computer, such as another presentation.
o  New Document: Create a link to anew document.
4.  After we have selected the document, click Save to create the link.
This makes it easy to navigate between related presentations and other resources.
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Exporting a Presentation

Sometimes, we may want the presentation in different formats. To save our presentation in a
different format, we can use the File — Export command. This lets us convert the slides into various
file types like PDF, JPEG or GIF.

Here are the steps to follow:
1. Openthe presentation you want to export.

2. Go to the File menu and select Export. Export dialog box will open as shown in figure
10.23.
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Figure 10.23 : Exporting a Presentation

3. Inthe Exportdialogbox find the ‘Save as type’ dropdown menu.

4. From the menu, choose the format. We have a wide range of options, including PDF,
HTML, BMP, GIF and JPEG.

5. Click Save. Our presentation will now be exported in the format we selected.

Selecting Template to create a Presentation

Using a pre-made template is a great way to start a new presentation. Templates provide a ready-
made structure and design, saving the time and effort.

Here is how to create a new presentation from a template:
1. Open the File menu and navigate to the New submenu.

2. Select the Template option. This will open the Template Manager dialog box as
shown in figure 10.24.
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Figure 10.24 : Selecting Template

3. Choose the template you want to use, then click Open.

Your new presentation will now open with the design and structure of the template you selected.

Guidelines for a Good Presentation
Delivering a great presentation can be challenging, but with the right preparation, we can deliver a
clear, engaging, and impactful message.

e  Know the audience: Before creating our slides, understand who we are speaking to.
Tailor your message, examples and depth of information to their needs.

e  Createaclear narrative: Have a clear beginning, middle and end to guide the audience.

e  Keep it simple: Focus on a few core messages. Don't try to cram too much information
into one presentation, as it can overwhelm the audience.

e  Minimal text: Use bullet points sparingly and keep them short. Slides should support
our message, not be a replacement for it.

e  Use high-quality visuals: Incorporate professional, high-resolution images, charts and
graphs. Visuals are often more powerful than text.

e  Maintain consistent design: Use a consistent color scheme, font and layout throughout
the presentation for a polished and professional look.

e  Choose a readable font: Select a simple, clean font and ensure it is large enough to be
easily read from the back of the room.

By focusing on these key areas we will be well on our way to giving a memorable and effective
presentation.
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Summary

We learned some advanced LibreOffice Impress features to help you create more dynamic
slideshows. We explored applying transition effects to animate how slides appear, and custom
animation effects to bring individual objects on your slides to life. We have used slide master to add
consistent content across all slides and even created our own custom Slide Master with personalized
elements. We have learned to insert drawings using the various tools in the Drawing toolbar. We also
explored Page Setup to customize the look of our slide settings. We have successfully created
Custom Slide Shows using a selection of slides from our presentations. We also learned how to set
precise timings for each slide using the Rehearse Timings feature, how to link a presentation and how

to export a presentation in various formats.
EXERCISE

How do we open a saved presentation in Impress?

How do we apply slide transitions to a presentation?

Write steps to add custom animations to objects on a slide.

What sections are included in the 'Custom Animation' dialog box?
How do we insert page numbers on every slide in a presentation?
What advantages does creating a custom slide master offer?

List the tools available in Impress's 'Drawing'toolbar.

What settings can be adjusted in the 'Page’and 'Background'sections of 'Page Setup'?

S ® AW DD

How would we describe a custom show in presentations?

[y
=

How do we set automatic slide timings for a whole presentation?

k.
k.
.

State whether true of false.

(1)  Wecannot create a new slide master in Impress.

(2)  'Rehearse Timings'option is available in '"Tasks Pane'.

(3) Slide transitions can be set to 'Slow’,' Medium', or 'Fast'speeds.

(4) The'Add' button in' Custom Animation'applies an animation effect to a selected object.

(5) The'Header and Footer'dialog box includes options for Date and Time.

12. Fill-in the blanks.

(1) provides an artistic text effect.
(2) provides a template for our presentation.
3) is a visual effect that appears when one slide moves to next.
(4) Custom Animation feature is used to give effects to any object on slide.
(5) decides timings for each slide in presentation.
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13. Multichoice questions. Choose the most correct answer.

(1)  Which is the shortcut key to open an existing presentation in Impress?

(a) Ctrl+P (b) Ctrl+S (c) Ctrl + X (d) Cul+0O

(2)  Which section of the 'Tasks Panes' is used for applying animations to slide objects?
(a) Slide Transition (b) Master Slide
(c) Table Design (d) Custom Animation

(3)  Which menu has the 'Master > Slide Master' option?
(a) Slide Master menu (b) View menu
(c) Slide menu (d) Slideshow menu
(4)  Which tool in the 'Drawing’ toolbar is used to create a circle shape?
(a) Circle (b) Ellipse (c) Rectangle (d) Arrow
(5) Which tool is used to create artistic text effects?
(a) Slide Transition (b) Custom Animation
(c) Slide Master (d) Fontwork Gallery
(6)  Which menu allows us to adjust slide margins?
(a) Print Setup (b) Slide Setup (c) Show Setup (d) Page Setup

(7)  Which option in the 'Background'’ section allows us to use an image as the slide

background?
(a) Hatching (b) Color (c) Bitmap (d) Gradient
(8)  What feature allows us to selectively show slides in a presentation?
(a) Slide Show (b) Slide Transition
(c) Custom Show (d) Rehearse Timings
(9)  Whichbutton in the 'Define Custom Slide Show'dialog box adds selected slides?
(@) > (b) < (0) >> (d) <<

(10) Whichmenu has the'Rehearse Timings'option?
(a) Edit (b) Slide (c) Slide Show (d) Tools

Laboratory Exercise

1. Apply transition effects to all slides in our previous presentations.

2. Apply animation effects to all the objects in our previous presentations.

3.  Create a custom slideshow using a selection of slides from our school presentations.

4.  Set appropriate timings for all slides across our presentations.

5.  Add the date, time, and page numbers to one of our presentations.

168 Computer Studies : Std-9

Get More Learning Materials Here : & m &R www.studentbro.in



6.  Design a new slide master with your preferred options.

7.  Draw something similar to the image below using the drawing toolbar in our slide.

o Atshewiththenature...

R/
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